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Welcome to COLUMBUS

What is COLUMBUS?

COLUMBUS is a one-, two- and three-dimensional network adjustment, network pre-analysis and
coordinate transformation software package which allows you to create, edit, solve and analyze, Vertical,
Geodetic, State Plane, UTM, Custom Projection and Local NEE (north, east, elevation) surveys anywhere
in the world. COLUMBUS accepts terrestrial and/or GPS (satellite) observations to define networks.

To report coordinate results in different form, COLUMBUS provides a powerful set of coordinate
transformation tools to generate Geodetic, State Plane, UTM, Custom Projection, Earth Centered Earth
Fixed Cartesian, or Local North, East and Elevation (NEE or NEU) positions. To transform geodetic
positions from one datum to another, COLUMBUS provides rigorous three-, four- and seven-parameter
least squares datum transformation capability. COLUMBUS also includes an assortment of Geodetic, State
Plane, UTM, and Local NEE coordinate geometry (COGO) routines for ad-hoc computations, network loop
closures and open-ended traverses.

COLUMBUS also adjusts networks using PLSS cadastral records. This feature allows the generation of
accurate geographic, State Plane, UTM or Local NE positions from surveys which have already been
completed. Cadastral networks can be adjusted in 2D space at a fixed height. This feature is very useful
for building GIS databases where the best possible 2D coordinate positions are required.

Background

Until the advent of the PC, the adjustment of geodetic surveys could only be facilitated by large mainframe
computers. Field observations were entered into rigid data files, pre-processed, then submitted to a host
computer. If all data were properly entered, a solution could be computed. For small- to medium-sized
firms, the costs were prohibitive, and so geodetic theory was not put into practice.

As an alternative, projected math models (State Plane, UTM, Local NEE, etc.) were developed which
greatly simplified computations. However, these models only approximate the Earth's true shape and using
them introduces distortion. Their widespread use was justified (in the past), because the data collected in
the field were no more accurate than the chosen projection mathematical model.

Today, angles, distances and GPS vectors can be measured with greater accuracy than ever before. With
full implementation of the GPS constellation and integration with GLONAS and the Galileo, coordinate
projection models no longer provide a level of accuracy commensurate with the quality of the observations
obtained in the field. Geodetic mathematical models should be used to obtain the highest quality results
possible (especially on medium to large projects).

Geodetic theory has been in use for many years by the National Geodetic Survey (NGS) to define
horizontal and vertical control across the United States (USA). With geodetic mathematics, field
observations are adjusted in 3D geodetic space. Since no distortions are introduced, the results are
superior to other methods.

Who needs geodetic capability? Anyone who demands the highest possible level of numerical accuracy.
COLUMBUS delivers the power of geodetic theory into every personal computer.
Copyright 1998-2009 Best-Fit Computing, Inc.
1-3



Upgrades

As the science of geodesy, applications of land surveying and field practices continue to improve,
COLUMBUS advances with them. COLUMBUS is continually enhanced to meet the needs of these
evolving disciplines. Upgrades are provided to registered users at a nominal cost. This exemplifies our
commitment to our product and our users.

COLUMBUS is compatible with several types of GPS satellite receiver baseline output. If you own or have
access to receivers that are not supported by COLUMBUS, please contact us. We will be happy to work
with you and the receiver manufacturer to configure COLUMBUS to meet your needs.

Technical Support

COLUMBUS service does not end once the product is in the hands of the surveyors and engineers who
will apply it. We provide technical support throughout the life of the product to all registered users. We
invite any question, specific or general in nature. If we cannot answer the question over the phone (or
email), we will follow up with whatever is required to meet your needs. In addition, we appreciate your
comments and suggestions about COLUMBUS.

You may contact Best-Fit Computing at the following in Beaverton, Oregon USA:

Email support@bestfit.com
Fax (503) 214-5406
Phone (503) 531-8819
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Getting Started

To assist you in learning the basics of COLUMBUS, we have provided 16 ASCII (Text *.TXT) data files and
their report output (*.TXT). For a brief tutorial of one of these files, please refer to APPENDIX C. We have
also included a sample geodetic network in the ASCII (Text) file BIGBASIN.TXT. We refer to data in this
file throughout the manual. For more information, see the EXAMPLE NETWORK section of this
chapter.

Before continuing, please check the COLUMBUS package to ensure that the following have been
received:

1. Installation CD, which contains the complete program and demo files, GEOID03, GEOID99 and
DEFLEC99 grids, the EGM96 geoid grid, and the User Manual (in Adobe Acrobat PDF format). 

Note: You will need the Adobe Acrobat Reader to view the User Manual. It is available at no charge
from Adobe's Web site at http://www.adobe.com

2. Software Activation Instructions.

If these items are not present, contact Best-Fit Computing immediately. 
Copyright 1998-2009 Best-Fit Computing, Inc.
1-5



System Requirements

The system requirements for COLUMBUS are listed below.

PC or 100% compatible Microsoft Windows XP or Newer Operating System
Mouse recommended

COLUMBUS allocates memory dynamically. The network size which can be solved will depend upon the
amount of available disk and memory resources on your computer.
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Installing COLUMBUS

COLUMBUS can be installed and operated on any PC running the Windows Windows XP or Newer
operating system.

To install COLUMBUS, insert the CD into the CD ROM drive. From the Start menu, select Run, type the CD
ROM drive letter, followed by setup.exe (for example, f:\setup.exe) and click OK. Alternatively, from the
Start menu, select Programs and then Windows Explorer. Select the CD ROM drive and double-click on
setup.exe. Follow the instructions of the installation program.

We have provided 16 ASCII (Text) data files which demonstrate a few different network adjustment
scenarios within COLUMBUS. Below is a brief description of each file:

Below is a description of each file:

BEAR2D.TXT This project file contains a small 2D geodetic network (one half of a PLSS 
section from a township) consisting of recorded mean bearing and horizontal 
distance survey data.

BIGBASIN.TXT This project file contains a network consisting of 17 stations (four of which are 
3D control stations) and 126 GPS and terrestrial observations. This sample is 
also used for demonstrating the Solve All Combinations logic described at the 
end of this document.

BIGBASIN_NET.TXT This project file has the same stations and observations as BIGBASIN.TXT. It 
also contains all the applicable Option Settings and fixed station settings. 
Review the BIGBASIN.RPT file for this project.

GEO.TXT This project file contains a small 3D geodetic network consisting of geodetic 
stations and terrestrial observations. This project contains the same data as the 
GEO_TRAV.TXT project.

GEO_TRAV.TXT This project file demonstrates 2D and 3D geodetic traversing. This project 
contains the same data as the GEO.TXT project.

GPSONLY.TXT This project file contains a small 3D geodetic network consisting of geodetic 
stations and GPS observations.

MIXED.TXT This project file contains a small 3D geodetic network consisting of geodetic 
stations, and a mix of GPS and terrestrial observations.

NEE.TXT This project file contains a small 3D Local Horizon Plane NEE network, which 
can be adjusted using the local NEE adjustment engine.

NEE_TRAV.TXT This project file demonstrates 2D and 3D Local Horizon Plane NEE traversing. It 
does not contain the same data as NEE.TXT.

STATEPLANE.TXT This project file contains a small 3D State Plane network consisting of State 
Plane stations and terrestrial observations. This project contains the same data 
as the STATEPLANE_TRAV.TXT project.
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STATEPLANE_TRAV.TXT This project file demonstrates 2D and 3D State Plane traversing. This project 
contains the same data as the STATEPLANE.TXT project.

TERRONLY.TXT This project file contains a small 3D geodetic network consisting of geodetic 
stations and terrestrial observations. This network can also be adjusted in 2D at 
an average project height.

TRIGLEVEL.TXT This project file contains a sample data set (with instructions) for processing Trig 
Levelling data. There is no report file for this project.

UTM.TXT This project file contains a small 3D UTM network consisting of UTM stations 
and terrestrial observations. This project contains the same data as the 
UTM_TRAV.TXT project.

UTM_TRAV.TXT This project file demonstrates 2D and 3D UTM traversing. This project contains 
the same data as the UTM.TXT project.

VERTICAL.TXT This project file contains a small 1D vertical network consisting of height stations 
and height difference (levelling) observations.

For each project file, we have included a report (*_RPT.TXT) file. Before exploring each sample file, you
may find it helpful to review the corresponding report file.

Before loading each sample file into COLUMBUS, take a moment to examine its contents for
instructions on how to process the data contained in the file.
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Your Access Code

When you install COLUMBUS and run the program for the first time, you will be prompted for an access
code. Your access code is a function of the Serial Number shown in the prompt dialog. Write down the
serial number and contact Best-Fit Computing to obtain your access code.

The access code is machine-specific. Once you have entered the correct access code, you will be able to
run COLUMBUS in full-feature mode (you will be able to load and append files). Without the access code,
all data must be loaded through the DATA input screens. Save your access code number for your records.

To complete the Access Code verification, you may need Administrator rights on your computer.
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How COLUMBUS is Organized

COLUMBUS is organized around nine functional areas. Following are brief descriptions of each function.

FILE
The File menu provides file management tools for creating a new project, opening data into a new
project (Figure 1 below), appending data to an open existing project, saving the current project,
extracting data from third-party data files, and print/print preview of the current project and network
adjustment/pre-analysis results.

Figure 1: MIXED.TXT Network View

VIEW
The View menu allows you to change the view context of the active project. For example, you can view
a network in one of the following contexts: 1D Vertical, 2D Geodetic, 3D Geodetic, Cartesian XYZ,
State Plane (2D), State Plane (3D), UTM (2D), UTM (3D), Local NE (2D), or Local NEE (3D). The
available context options are dependent on the type of data in the project.

The majority of computations within COLUMBUS are dependent on the active project view.

From this menu, you can also set up or clear a route (sequence of stations), resize network entities
(station names, station symbols, and error ellipses), zoom in or out on a defined area of the active
project, display/hide stations, the toolbar and the status bar.

DATA
The Data menu facilitates the entry or editing of data (stations, observations and datums) for the
current project. A complete project can be entered here using our advanced spreadsheet like data
entry grids.
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From this menu, stations and observations can be deleted or observations can also be temporarily
disabled to exclude them from Network Adjustment/Pre-Analysis and COGO processing.

NETWORK
COLUMBUS adjusts networks using the method of Indirect Observations (also known as the Unified
Approach.) This is the most common method in use today. Much of the adjustment theory built into
COLUMBUS has been adopted from papers published by the National Geodetic Survey in the U.S.A.
Overall, the theory used within COLUMBUS has been taken and combined from several leading
independent sources. We provide a complete list of references to these sources within the Appendix D
and on our Web site (http://www.bestfit.com) from the Theoretical Foundation link.

The Network menu provides all the tools required to adjust one-, two- and three-dimensional vertical,
geodetic, State Plane, UTM, Custom Projection and local NEE networks. The type of network
adjustment to be performed is dependent on the current project view. For example, if the current view
is 2D geodetic, then a 2D geodetic adjustment can be performed. Likewise, to perform a 3D geodetic
adjustment, the 3D geodetic view must be active.

You can also perform network pre-analysis on 2D and 3D geodetic, State Plane, UTM and Local NEE
surveys. Network pre-analysis (commonly called design) enables you to design your survey before
going into the field. Simply provide COLUMBUS with the approximate locations of your planned survey
points (scaling from a map is usually adequate), the observation types you expect to measure, and the
expected precision for each observation, expressed as a standard deviation or covariance matrix (for
GPS baselines). COLUMBUS can then compute the statistical level of precision you can expect to
achieve, based on your design. If your design is not adequate for the future adjusted precision desired,
make changes and analyze your design again. Network pre-analysis can save valuable time in the
field by allowing you to optimize your network geometry, and the types and frequency of the
observations which you need to measure. Please visit our Web site for more help on setting up a
Network Design under the applicable Quick Tips topic.

RESULTS
The Results menu allows you to view the network adjustment results. Several views can be displayed
simultaneously, including an adjusted view of the network - complete with resizable error ellipses and
height error bars. For each view, you can use the Print and Print Preview manager to further
examine each report as hard copy or onscreen. The results from each view can also be written to a
report file (see report toolbar icon) and to an Excel CSV comma delimited file (just data, no formatting.)

TOOLS
The Tools menu provides powerful tools for transforming geodetic coordinates to several other
coordinate systems, performing COGO computations and much more. Tools menu options can be
used alone or in combination with the Network menu options.

Most of the options within the Tools module are context-sensitive to the main project graphical
view or network adjustment graphical view. Look to the title bar for each Tool option to determine
the context. For example, if the network adjustment graphical view is active, applicable Tool options
are based on the adjusted coordinates. If the main project graphical view is active, applicable Tool
options are based on the data for each station, i.e., data that are in the project.

The Transformation option is one of the most powerful features of this module, giving you the ability to
transform geodetic coordinates based on one datum (NAD 83, WGS 84, etc.), to geodetic coordinates
based on a second datum (NAD 27, Bessel, etc.). Also, you can transform geodetic coordinates to and
from ECEF Cartesian, State Plane (several projection methods supported), UTM and Local NEU.
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Resulting coordinates can quickly be exported to other software systems.

The COGO (coordinate geometry) option provides tools for vertical, State Plane, UTM, Local NEE and
geodetic coordinate geometry computations.

The remaining Tools menu options allow you to compute areas, scale projected coordinates, model
geoidal heights and deflections of the vertical, create NGS NADCON input files, and export data to a
DXF or user-defined data file.

OPTIONS
The Options menu allows you to change the run-time parameters within COLUMBUS.

WINDOW
The Window menu allows you to arrange your work area, following the standard Microsoft Windows
conventions. You can Cascade or Tile your open COLUMBUS projects and views. Using the Arrange
Icons command, you can arrange your iconified project icons. Finally, a list of the open COLUMBUS
projects, with the active project checked, is provided.

HELP
The Help menu provides access to the Index to COLUMBUS’ extensive Help system. Information is
also provided about using Help and about your current version of COLUMBUS.

NOTE ABOUT REPORT VIEWS
Most numerical results are presented in list report form. These reports contain multiple resizable
columns that can be customized by you to only show the columns you want. Changes made to any
column alignments are automatically saved for future COLUMBUS sessions.

Each column in a list report can be sorted (ascending and descending) by clicking on the column
header. The order of the printable report will match the current sorted column on screen.

Each and every report can also be written to a comma-delimited (Microsoft Excel CSV compatible) file
format. These files contain the actual results without all the normal formatting. In this way, your data
can be easily loaded into Excel for further manipulation. Because the Excel CSV file is a simple
comma-delimited file, you can also import these files directly into other software packages for
further processing, drawing, etc.

To activate the generation of CSV files, select Report Headings command from the Options menu
and enable the Create comma-delimited text report… check box. When you send the results of any
list report to a report file, a corresponding Excel CSV file will also be created with the extension *.csv
(using the same report file name and in the same folder.)
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Project Data Model

COLUMBUS is a completely integrated system. From within one program, several types of computations
can be performed. Users of COLUMBUS find that many of the tasks which previously required separate
programs can be solved within the COLUMBUS environment. Unlike other network adjustment programs,
COLUMBUS opens all station and observation data into a project for manipulation and computation. The
data are available until you close the project.

One of the most powerful features of COLUMBUS is its built-in data sharing. Once data have been entered
within the Data module or opened within the File module, they are available for computations in any of the
applicable numerical modules. If a network has been recently opened, the data can be used to quickly
perform inverses or loop closures. Station data can be easily transformed from one coordinate system to
another.

Figure 2: COLUMBUS Data Hierarchy

Project usage in COLUMBUS is similar to the process of making changes to a file using a text editor. Once
data have been opened into a project, they can be modified, appended or deleted without affecting the
original data on disk. Within COLUMBUS, data in a project are saved to disk only when you select from the
File menu either the Save or Save As options, or select from the Network menu the Save Network option.
Like having several versions of a project with minor modifications in each, you can have several versions
of the same data in separate disk files. This is accomplished by continually saving data in your project to
separate disk files (or the same file if preferred) following each alteration.

Not only can different modules gain access to your data, each numerical module has the ability to Keep
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new data into the active project from current computations. For example, you perform a geodetic network
adjustment, but need to report the adjusted geodetic positions in State Plane (projected) form. Once the
adjustment is completed, you can Keep the adjusted geodetic coordinates into the active project using the
RESULTS - KEEP command or toolbar button, giving other modules access to the adjusted coordinates.
You can then move to the Tools module and select STATE PLANE <--> GEODETIC to transform the
adjusted geodetic coordinates to State Plane coordinates. 

Note: Another way to accomplish this is to perform the network adjustment, then open the Adjusted
Network view. From the Tools menu, select the Geodetic to State Plane transformation. Since the Adjusted
Network view is active, the transformation computations will be based on the adjusted geodetic
coordinates.

The advantage of this system is the elimination of re-entering computed coordinates. This minimizes the
possibility of data entry errors and saves valuable time. This feature also removes the needless
construction of multiple intermediate data files which tend to clutter your disk directories. With
COLUMBUS, each project can conceivably be stored in one data file or across several data files.
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ASCII (Text) Files

COLUMBUS supports two file formats for data files. Each format can be used independently or combined
together in the same file.

The expanded format usually spans more than one line of file text for each input record. This format is
used in this document to prevent data files from wrapping on the page. This format is being phased out.

The compact format allows you to define an entire input record on one line of text. Data fields are
separated by the semicolon character (’;’). All demo data files (with *.txt extension) are in this format.

COLUMBUS also supports the concept of an include file list. From within each file, you can include other
files. These included files are automatically loaded by COLUMBUS. If your project is made up of dozens of
input files, you can create one master input file (e.g., master.txt), which then includes all the project files.
See Appendix A for details on using the $INCLUDE_FILE keyword.

For any project, you can either create your data set within an ASCII (Text) data file (using an external text
editor, e.g., Notepad) or within COLUMBUS, by using the powerful spreadsheet style data entry grids.

The ASCII (Text) file has four main types of data: Datums, Units, Stations and Observations. Each type can
be repeated in the file as often as you like. 

Stations can either be explicitly or implicitly defined within the file. To explicitly define each station you must
provide its coordinates. To implicitly define each station, simply add this record type to the top of the file:

$STATION_TYPE_FOR_OBS
3D_GEO (or 1D_VERT, 2D_GEO, 3D_ECEF, 2D_STATE, 2D_UTM, 2D_NE, 2D_NEU)

When the file is opened, the applicable station type will be automatically created (with coordinates of zero)
when an observation is read, which reference the station.

When creating the ASCII (Text) file, most types of data are optional. If the Datum data is not included, the
opened data is linked to the active datum. If the Units data is not defined, all linear values are assumed to
be in the active linear units. All applicable angular values are assumed to be in the active angular units.

Please see APPENDIX A to review several example ASCII (Text) data files.
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Datums

A geodetic datum is a mathematical model designed to best fit part or all of the geoid (Earth’s surface at
mean sea level). It is defined by a reference ellipsoid and the relationship between the reference ellipsoid
and a point on the topographic surface established as the origin of datum. This relationship can be defined
by six quantities, generally (but not necessarily):

The geodetic latitude, longitude and height of the origin,
the two components of the deflection of the vertical at the origin,
And the geodetic azimuth of a line from the origin to some other point. 

The World Geodetic System 84 (WGS 84) datum gives positions on a specified ellipsoid with respect to the
center of mass of the Earth.

In this manual when we refer to the datum, we are referring to the parameters of the reference ellipsoid.
These parameters are the semi-major and semi-minor axes of the reference ellipsoid. Another way of
expressing the reference ellipsoid is with the semi-major axis and the flattening. Some of the datums used
throughout the world are listed below. The semi-major and semi-minor axes are expressed in meters and
are often represented by the lower case letters “a” and “b,” respectively. The ratio 1/f (f = flattening
coefficient) can be computed from “a” and “b” using the equation:

ELLIPSOID SEMI-MAJOR AXIS (a) SEMI-MINOR AXIS (b) 1/f

Airy 6,377,563.396 6,356,256.910 299.32496
Australian N. 6,378,160.0 6,356,774.7192 298.25
ATS 77 6,378,135.0 6,356,750.305 298.257
Bessel 6,377,397.155 6,356,078.9629 299.1528128
Clark 1866 6,378,206.4 6,356,583.8 294.9786982
Clark 1880 6,378,249.145 6,356,514.8696 293.465
Everest 6,377,276.34518 6,356,075.41511 300.8017
GRS 80 6,378,137.0 6,356,752.3141 298.257222101
Hayford 6,378,388.0 6,356,911.9462 297
International 6,378,388.0 6,356,911.9462 297
Modified Airy 6,377,340.189 6,356,034.446 299.325
Modified Everest 6,377,304.063 6,356,103.039 300.8017
NAD 27 6,378,206.4 6,356,583.8 294.9786982
NAD 83 6,378,137.0 6,356,752.3141 298.257222101
WGS 72 6,378,135.0 6,356,750.5 298.26
WGS 84 6,378,137.0 6,356,752.3142 298.257223563

COLUMBUS is shipped with several pre-set datums (a few of the internally supported datums are shown
above). You can delete or add new datums to COLUMBUS within the DATA - DATUMS dialog box. Note:
Some datums have identical or nearly identical parameters.

1
f
--- a

a b–
------------=
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Coordinate Systems

Several coordinate systems are used in the practice of surveying. Different systems have been developed
over the years to facilitate differing needs. Prior to the computer, many surveys were computed on simple
Local NEE or Local XYZ coordinate systems. These systems make computations easier, but also
introduce distortions, since the Earth’s surface is not flat. As an alternative, projected coordinate systems
were developed to more accurately model the Earth's true shape within a limited region. While these
systems have limitations, they are superior to Local NEE or Local XYZ coordinate systems.

With the advent of differential GPS, many surveyors switched to geodesy to accurately analize their survey
data. The science of geodesy has been available for several hundred years. However, the mathematics
are considerably more complex than simple Local NEE or Local XYZ computations, and so geodesy has
not been widely used. Today, geodesy can be easily applied through the use of PC-based software
systems.

Before we begin discussing some of the commonly used coordinate systems, it may be helpful to define
Precision and Accuracy. These terms are commonly interchanged, but have very different meanings.

PRECISION: The degree of closeness or conformity of repeated measurements of the same quantity to
each other. They may or may not reflect the true value.

ACCURACY: The degree of conformity or closeness of a measurement to the true value.

When we speak of accurate coordinates or observations, we are referring to the closeness of their
measured values to their true values. When we speak of the precision of coordinates or observations, we
are referring to the repeated measurement of the same value.

It is possible to measure a traverse, such as a loop, and compute a high-precision closure on a Local NEE
mathematical system. We may achieve an excellent closure and believe our survey is good. In fact, if we
were to measure the same traverse repeatedly, we would probably compute similar results each time. But,
is the survey accurate? That depends on the size of the loop. Most Local NEE systems are only accurate
within a limited area, due to the continuously changing convergency of the meridians and curvature of the
Earth's surface. In short, the survey may have high precision, but may not accurately define the true
position for each station along the traverse.

The geodetic model, on the other hand is geometrically exact. It fits the Earth's true shape better than
any other coordinate system. By selecting a datum which closely matches the size and shape of the
Earth's surface (for your country, region, etc.) and using the same field data, you can compute the position
for each station along the traverse with high precision and high accuracy. This is because geodesy looks at
the Earth as an ellipsoidal surface and not as a flat surface. Distances of almost any length can be used.
GPS vectors can be hundreds of kilometers apart. For this reason, the geodetic model is fast becoming the
preferred method for processing survey data.
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Geodetic Coordinates

The geodetic coordinate system is based on an ellipse rotated about its semi-minor axis, thus forming an
ellipsoid. The ellipsoid is designed to model the Earth's actual shape at mean sea level. The semi-minor
axis of the ellipsoid extends from the origin (center) of the ellipsoid north and south to the poles. The semi-
major axis extends from this origin to the equator. Every ellipsoid can be mathematically defined by the
semi-major and semi-minor axes. Any position on, above or below the ellipsoidal surface can be exactly
defined by its latitude, longitude and ellipsoidal height.

The Meridian Ellipse

The latitude is the angular distance along a meridian extending north or south from the equator. Northern
latitudes are positive, while southern latitudes are negative. The radius of the latitude is constantly
changing as we move north or south along a meridian. This complicates most geodetic computations. In
fact, early geodesists represented the Earth with a sphere instead of an ellipsoid. This made computations
more straight forward, since the radius is constant along any distance.

The longitude is the angular distance measured westward and eastward from the meridian extending
through Greenwich, England. Longitudes to the east of Greenwich (0 to 180) are positive. Longitudes to
the west (0 to -180) are negative. At any given parallel of latitude, the radius of the longitude is constant.

Finally, the ellipsoidal height is the vertical distance above or below the surface of the ellipsoid. Heights
above the ellipsoid are positive, while those below are negative. 

Some ellipsoids are designed to fit the entire Earth (e.g., WGS 84, a global ellipsoid), while others are
designed to fit only a portion of the Earth's surface (e.g., Bessel, a local ellipsoid).
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Geocentric Coordinates

Geocentric coordinates are based on an Earth Centered Earth Fixed (ECEF) 3D cartesian coordinate
system. A geocentric coordinate system origin is relative to the center of mass of the Earth. Any point in
this system can be defined by an X, Y and Z coordinate. 

Global Coordinate System

Differences between points are defined by delta X, Y and Z vector components. GPS observations are
based on the WGS 84 datum, which is a geocentric coordinate system. All geocentric coordinates can be
expressed in geodetic coordinates of latitude, longitude and ellipsoidal height, but not all geodetic
coordinates can be expressed as truly geocentric, since the reference ellipsoid may not have its origin at
the center of mass of the Earth.

A common practice is to measure GPS vectors on the WGS 84 geocentric system, but use them in
computations on a non-geocentric coordinate system, with the idea that a vector in space is still a vector,
no matter what space it is in. This concept is not entirely workable unless the vector can be rotated and
scaled to fit the secondary coordinate system (such as Bessel). The magnitude of any measured vector is
good in any coordinate system, but the orientation usually must be corrected. COLUMBUS can do this for
you automatically in the NETWORK module by first enabling GPS vector rotation and scaling in the
OPTIONS module.
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Projected Coordinate Systems

Projected coordinate systems were first introduced hundreds of years ago in order to simplify high
precision survey mathematics and to project geodetic coordinates to a flat surface for mapping purposes.
Throughout the world, two common projection systems are used: the Lambert projection and the
Transverse Mercator projection.

Projected coordinates are usually expressed by a northing and easting component. False northing and
easting components are defined for each projection zone to force all north and east coordinates to be
positive. The mapping angle and scale factor at each point accompanies the north and east coordinate.
The mapping angle is the angular difference between north on the projected system (grid north) and true
north of the geodetic meridian at that point. The scale factor is the ratio of the distance along the projected
system to the ellipsoidal surface (at ellipsoidal height of zero which closely approximates mean sea level).
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Local NEE Coordinate Systems

The local horizon NEE (north, east and elevation) coordinate system is widely used in many parts of the
world. It is by far the easiest system on which to perform computations. The Local NEE coordinate system
should be used only over small areas if high accuracy is important, since the Earth is not flat. The local
NEE system allows for corrections due to curvature of the Earth's surface. COLUMBUS supports this type
of coordinate system in a network adjustment. These projects should only span a square kilometer or
less.

The traditional Local NEE system is created by placing a flat surface (plane) tangent or secant to the
ellipsoidal surface at some point of origin. As we move away from this point in any direction, we begin to
move away from the Earth's surface (i.e., above the Earth surface), which causes distortion. The Local
NEE system has been widely used, partly because software systems are abundant. In fact, many
surveyors have written a simplified program to compute coordinates on a Local NEE model.

Many people are confused by 3D network adjustment systems based on the Local NEE surface and 3D
geodetic network adjustment systems. The former system is greatly simplified. The latter system, upon
which COLUMBUS is based, is routinely used by geodesists to accurately determine locations on the
Earth's surface over small or large distances. 

COLUMBUS allows you to adapt your current field gathering techniques to the geodetic model. With the
same field observations, you can achieve superior results for projects of any size than could ever be
obtained with Local NEE systems. However, if you still need coordinates based on these systems,
COLUMBUS gives you the tools to transform geodetic coordinates of latitude, longitude and ellipsoidal
height to Local NEE systems after a geodetic traverse or adjustment has been completed.

COLUMBUS supports network adjustments based on Local NE (north, east) and Local NEE (north, east,
elevation) over a small area. This option should only be used on small survey propjects spanning no more
than one square kilometer (as mentioned above). Although we have provided this logic, we highly
recommend that projects of any size be adjusted as either a 1D vertical, or 2D / 3D geodetic network. The
resulting coordinates can then be easily transformed to a Local NE or Local NEE system.
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Geoid Undulation

The geoid is the surface of the Earth at mean sea level. Unlike an ellipsoid which can be exactly defined at
any point, the geoid varies or undulates - sometimes above, sometimes below, mean sea level - from
location to location. All terrestrial observations are measured relative to the geoidal surface. Since the
geoid in not easy to mathematically model, geodesists use an ellipsoid to closely approximate the geoid for
different regions of the world. Some ellipsoids are global, meaning they model the entire Earth's surface
relatively well (e.g., WGS 84). Other ellipsoids are locally defined, meaning they fit select portions of the
Earth's surface relatively well (e.g., Bessel, in parts of Europe). 

Geodesists can successfully use an ellipsoid to model the geoid by understanding the mathematical
relationship between the two systems at any given location. For geodetic surveys, these differences are
due to deflections of the vertical and the differences between the vertical components at any location. The
vertical component measured from the geoid is the orthometric height or elevation (H). The vertical
component measured from the ellipsoidal surface is the ellipsoidal height (h). At any given location, the
difference between the ellipsoidal height and the orthometric height is called the geoidal height (g).
Knowing any two, you can determine the third component using the following relationship:

Heights

One of the many attractive features of GPS is the ability to accurately measure the Earth's surface in three
dimensions (latitude, longitude and ellipsoidal height). Prior to GPS, in order to establish a 3D position for
one or more stations, two separate surveys were usually performed. A horizontal survey was measured to
establish the latitude and longitude of each station. A vertical (leveling) survey was then run to establish
the orthometric height (elevation) for each station.

With GPS, we can determine the latitude, longitude and ellipsoidal height for each station during the same
observation period. Furthermore, we do not have to traverse in to each station to determine its position.
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GPS provides a very reliable and efficient means for determining positions, even for connected stations
hundreds of kilometers apart.

Unfortunately, ellipsoidal height is not always useful to the end user of the coordinates. The challenge then,
is to determine orthometric height (H) for each GPS-defined station from the ellipsoidal height of the
station. In many cases, we can use differential GPS to determine ellipsoidal height (h) within a few
centimeters. The orthometric height can often be determined to within a few centimeters using the
relationship:

if we know the geoidal height (g) at each station. While techniques exist to accurately determine geoidal
heights, they are very expensive to implement.

In the United States, extensive research into this problem is being undertaken. In fact, geoid modeling
systems for the NAD 83 datum have been developed (GEOID99 and GEOID03) by the National Geodetic
Survey (NGS) to estimate geoidal heights at any location between the latitudes of 24 to 50 degrees north,
and longitudes from 66 to 125 degrees west. In some areas, such as the Northeastern Coast, the geoidal
heights can be estimated to within a few centimeters of their true value. Orthometric heights that are
accurate to within a few centimeters can then be determined if the ellipsoidal height is known.

COLUMBUS also supports EGM96, a worldwide model which can be used by anyone. For more
information on these models and support for additional models, see the TOOLS chapter of this manual.

Another commonly used practice to compute orthometric heights for each station is to perform a GPS
based 3D Geodetic adjustment using orthometric height instead of ellipsoidal height to control the vertical.
In other words, the orthometric height field for each fixed station (1D and 3D fixed) is used to control the
vertical component of the network. The quality of results will vary from region to region. To get the best
results, the geoidal undulation in the project area should be constant (or within a few centimeters,
depending on your accuracy requirements). Furthermore, your 1D and 3D control stations should be
evenly distributed throughout your network. Finally, you may improve your results by enabling rotation and
scaling of the GPS baselines (see the OPTIONS chapter of this manual for more information).

H h g–=
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Deflection of the Vertical

The deflection of the vertical is the angular separation between the normal to the ellipsoid (line
perpendicular to the ellipsoidal surface at a location) and the direction of gravity at that same location
(geoid normal). Since the direction of gravity is dependent on the geoid and not the ellipsoid, the normal to
the ellipsoid and direction of gravity rarely coincide exactly. Deflections of the vertical are expressed in
seconds in two primary directions: North - South and East - West.

Topography, Geoid, Ellipsoid

Deflections of the vertical corrections apply to the following terrestrial observations: azimuths, directions,
bearings, horizontal angles and zenith angles. Since surveying instruments are leveled in the direction of
gravity at any point, the terrestrial (Astronomic) observations should be corrected to ellipsoidal (Geodetic)
observations to attain the best computational results. The correction for each observation type can be
determined from the known deflections of the vertical at each station interconnected by the above
terrestrial observations.

If the deflections of the vertical are known at each applicable station, COLUMBUS can compute the
observation correction automatically. If you are unable to determine the deflection of the vertical at any
station, it may be to your advantage to estimate the deflection from nearby known stations. The National
Geodetic Survey (NGS) has developed grid files to estimate the deflections of the vertical at any location
within the United States (DEFLECT 99). COLUMBUS now supports the extraction of these deflection
values within the TOOLS module.

For 3D geodetic terrestrial networks, the accurate determination of the height at each station may be
dependent on the zenith angle measurement. Furthermore, if the deflections of the vertical corrections are
not known, your uncorrected (Astronomic to Geodetic) zenith angles may be off by several seconds.

COLUMBUS assumes all entered terrestrial observations are based on the geoid, i.e., those actually
measured in the field. Therefore, COLUMBUS always corrects these observations to the ellipsoid before
network adjustments or COGO computations (3D geodetic only), provided deflection of the verticals have
been supplied for the applicable connected geodetic stations, i.e., not defaulted to zero.
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Reporting Results

All numerical results are presented (within the user interface) in multi-column list format. Columns can be
resized as needed by dragging the column header separator left or right. Changes will be automatically
saved for future COLUMBUS sessions.

SORTING COLUMNS

You can sort any report list by individual list columns. Sorting by column allows you to more easily examine
results in the order you prefer.

To sort any column, simply left click on the applicable column label. To reverse the order of the sorted
column, left click on the column label again. Repeat as often as desired.

Sort By Absolute Value

When sorting columns containing real numbers (both positive and negative values), you can either sort the
column using the actual values displayed or you can sort the column by the absolute value of each number
displayed. This makes it very easy to examine data items for which the magnitude of the values may have
greater significance than the +- sign of the value (e.g., standardized residuals).

Sorting by Absolute Value can be enabled/disabled by invoking the View | Sort By Absolute Value menu
command, thereby toggling its checked status.

Sorting Efficiency

The internal sorting algorithm is very fast. This enables you to quickly sort lists which may contain
thousands or even hundreds of thousands of rows.

Sorting Reports

When examining list reports, the current sorted state will be reflected in the report file generated from
within the applicable list view or list dialog.

COMMA DELIMITED RESULTS

Each and every report can be written to a comma delimited file (Excel CSV compatible) format. These files
contain the actual results without all the normal formatting. In this format, your data can easily be loaded
into Excel or other software packages for further manipulation.

To activate the generation of the CSV file, select the Report Headings command from the Options menu
and enable the Create comma delimited text report... check box. When you send the results of any list
report to a report file, a corresponding file will also be created with extension *.csv (using the same report
file name and in the same folder).
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Example Network

COLUMBUS is not just a network adjustment package. It is a complete toolkit which can be used for on-
the-fly COGO computations, coordinate transformations and geoid modeling. If you need to compute the
areas for selected polygons in your project, simply use the COMPUTE AREA utility within the TOOLS
module. If you need to scale State Plane coordinates to an average orthometric height (elevation),
COLUMBUS is there to assist you. If you want to create a DXF drawing file from known coordinate
positions, simply enter the coordinates into COLUMBUS and proceed to the TOOLS module.

To help you better understand the many powerful features within COLUMBUS, we have put together a
typical 3D geodetic survey project. Originally designed to consist of only GPS observations, we discovered
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three stations which could not be measured with satellite positioning techniques. These stations were tied
into the 3D geodetic network using terrestrial (conventional) measurements (Stations 101, 102, 103).

The network BIGBASIN.TXT has four control stations with known WGS 84 coordinates (latitude, longitude
and ellipsoidal height). The four control stations are CARBON, FORT LEWIS, LA PLATA and CHANEY.
The remaining stations were assigned numeric station names (see diagram on previous page).

The solid lines represent the observed GPS baselines between stations. The dashed lines represent the
terrestrial observables. As described in the previous section, GPS baselines and terrestrial observations
are not completely compatible (only an issue when attempting to perform the very high accuracy survey).
GPS observables are based on a geodetic coordinate system (the reference ellipsoid). Some terrestrial
observations (azimuths, directions, horizontal angles and zenith angles) are based on the geoid (Earth’s
surface). Whenever possible, these terrestrial observations should be corrected from Astronomic (levelled
in the direction of gravity) to Geodetic (levelled in the direction of the ellipsoidal normal) in order to be fully
compatible with the GPS measurements. COLUMBUS automatically computes these corrections from the
deflection of the vertical data (N-S and E-W) at each connected geodetic station, if provided.

For our network, we have determined the deflection of the vertical for stations CHANEY, CARBON, 16, 21,
27, 101, 102 and 103 using the appropriate DEFLECT 93 grid file within the TOOLS module (use newer
Deflec 99 grid for your current surveys.) In many cases, you will not be able to determine the deflections of
the vertical for stations in your network. This should not discourage you from combining terrestrial
observables with GPS or from setting up elaborate terrestrial networks. If the deflections of the
vertical are minimal, the corrections will be negligible anyway.
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BIGBASIN.TXT ASCII (Text) File

Below are some comments regarding the sample data file BIGBASIN.TXT which is referred to throughout
the COLUMBUS user manual.

Because the file contains compact (single line records) it cannot be easily formatted for this document.
Please load the file BIGBASIN.TXT into your favorite editor (Notepad, Wordpad, Visual Studio, etc.) to
review its contents.

The coordinate positions within this file are the adjusted coordinates computed in the NETWORK
module. We put them here so you could open this file and move directly into any module to perform
computations based on the adjusted finalized positions. We could have entered zeros for the floating
station coordinates, because COLUMBUS automatically computes approximate coordinates to produce an
initial starting solution during network adjustment. The approximate coordinates are computed from the
selected control stations and observations.

Most geodetic projects follow a similar sequence of steps toward completion. Often the adjusted geodetic
coordinates are transformed to a projected coordinate system and then plotted using a CAD-related
package. With the data set BIGBASIN.TXT, we will demonstrate the use of the NETWORK and TOOLS
modules. Sometimes, we will demonstrate computations that you may never need to perform. Our purpose
is simply to explain, by example, how to effectively use COLUMBUS. You may want to print the complete
BIGBASIN.TXT file; we will be referring to it throughout this manual.

The adjusted positions shown in this file were obtained by performing a constrained adjustment with
stations CARBON, FORT LEWIS, LA PLATA and CHANEY held fixed in 3D. All other stations were set to
float. We also enabled rotation and scaling of the GPS baselines in the OPTIONS - NETWORK
OPTIONS - NETWORK SETTINGS dialog box. If you are already familiar with COLUMBUS, open the
BIGBASIN.TXT file within the FILE - OPEN dialog box and try duplicating our results. A complete listing of
the results from our adjustment is in the file BIGBASIN.RPT.

This network was adjusted on the WGS 84 ellipsoid. A commonly accepted practice is to compute geodetic
network adjustments based on the local ellipsoid for your area. 

For terrestrial networks, the observations should be corrected (for high accuracy surveys) from Astronomic
(levelled in the direction of gravity) observations to Geodetic (levelled in the direction of the ellipsoidal
normal) observations when adjusting based on ellipsoidal height. To do this, you must know the deflections
of the vertical at each occupied station. The deflections of the vertical are dependent upon the datum you
base your computations upon, since they represent the difference between the direction of gravity on the
Earth's surface to the direction of the specific ellipsoidal normal.

GPS observables are based on the WGS 84 datum. To use these observations with a local datum, the
baseline vectors should be oriented to the local datum. While there is no exact approach for achieving this,
COLUMBUS can compute a best-fit rotation (using a widely accepted method) by enabling the rotation
parameters in the OPTIONS - NETWORK OPTIONS - NETWORK SETTINGS dialog box. For this
technique to produce good results, your 1D, 2D and 3D control stations should be well-distributed
throughout your network. By switching on the scale parameter in the OPTIONS - NETWORK OPTIONS -
NETWORK SETTINGS dialog box, COLUMBUS scales each baseline to better fit the local control in your
area. The rotation parameters in the Local North, East and Up directions rotate the GPS vectors to better fit
your local geodetic control stations.

When you adjust a network, you should follow the general procedure described below:
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1. First, perform a free adjustment based on the local datum, holding one station fixed in 3D (or one
station fixed in 1D and another station fixed in 2D); any station can be used. The statistical results (not
adjusted coordinates) will be the same, since the adjustment in not constrained in any way. This will
give you the best indication as to the quality of your field data. The coordinate results may be off a bit
(from your final adjusted values following a constrained adjustment), but what is most important is the
estimated precision of your survey. Eliminate any questionable observations and re-adjust until you
obtain the best results.

2. Perform a constrained adjustment of the network with all your acceptable control stations and
observations. This will tend to distort your observations as they are forced to fit the control positions in
your network, which have their own inherent error (from prior surveys). Examine the outlier
observations estimated errors, PPMs and ratios within the distance error, error ellipse, error circles,
and error ellipsoid views. Eliminate any questionable observations and re-adjust until you obtain the
best results.

3. For networks containing GPS observables, turn on rotation and scaling (in the OPTIONS - NETWORK
OPTIONS - NETWORK SETTINGS dialog), then repeat Step 2. Compare the results from Step 2 with
those of this step. Use the method which delivers the best results. As always, experiment with various
combinations of control stations and observations until you are satisfied with the results.

There are many ways to adjust the BIGBASIN.TXT network. We adjusted the entire system at once.
Another approach is to adjust the GPS defined stations first, then hold these fixed and then adjust the
terrestrial portion. For this network, our terrestrial observations were as good or better than our GPS data.

Note: Portions of this network are fictitious. Furthermore, we have introduced some additional error to
certain observations to create a network with lower accuracy than the real-world survey. Carefully
executed field surveys can result in better adjustment results than what are demonstrated here.
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